Lesson 1

Excerpt from After Effects Apprentice, 2nd Edition. Copyright © 2009 Trish and Chris Meyer.
No part of this publication may be reproduced or distributed in any form or by any means.
Focal Press, ISBN 978-0-240-81136-9

14

Basic Animation
Building your first animation while you learn a typical After Effects workflow.
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creating folders in the Project panel
creating a new composition
importing files and folders
interpreting alpha channels
adding layers to the Comp panel
changing the Background Color
scrubbing parameter values
interactively transforming layers
animating Position; RAM Preview
navigating between keyframes
adding a background layer
dragging footage to the Timeline panel
editing a keyframe’s Bezier handles
editing spatial keyframes; motion paths
animating Opacity, Scale, and Rotation
arranging and replacing layers
adding solid layers
applying, copying and pasting effects
rendering
understanding the comp’s alpha channel
importing layered Photoshop and Illustrator files

탋 Getting Started
Make sure you have copied the Lesson 01-Basic
Animation folder from this book’s disc onto your hard
drive, and make note of where it is; it contains the sources
you need to execute this lesson. Our versions of these
exercises are in the project file Lesson_01_Finished.aep.

I

n this lesson, you will learn how to build a typical
After Effects project. Although the design itself is
simple, you will learn principles you can use over
and over again in the future. For example, you will
see how to import sources while keeping your
project file organized. As you add layers to a composition, you will learn how to manipulate their
transform properties, as well as how to keyframe
them to create animations. Along the way, you’ll
learn important tricks and keyboard shortcuts.
We’ll also discuss how to handle alpha channels
as well as layered Photoshop and Illustrator files.

Composition Basics
In the Pre-Roll section, we discussed the basic hierarchy of an
After Effects project: Sources are called footage items; when
you add a footage item to a composition (“comp” for short),
it is then known as a layer. Potential sources can include
captured video, Flash or 3D animations, photographs or
scans, images created in programs such as Photoshop or
Illustrator, music, dialog …even film footage that has been
scanned into the computer.
Layers are individual objects that can be arranged in a
comp’s space and animated around that space, similar to
symbols in a Flash project or models in a 3D animation
program. The order they are stacked in the Timeline panel
determine the order in which they are drawn (unless they
are in 3D space – we’ll get to that in Lesson 8). Layers can
start and end at different points in time.
All properties in After Effects start out static: You set them,
and this is the value they have for the entire composition.
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However, it is very easy to enable keyframing for virtually any property, which
means you can set what their values will be at different points in time. After
Effects will then automatically interpolate or “tween” between these values over
time. Once you enable keyframing, changing a property’s value automatically
creates a new keyframe – you don’t have to explicitly say “make new keyframe.”
You have considerable control over how After Effects moves between keyframes.
In this lesson, we’ll demonstrate editing the motion path for position keyframes,
and in the next lesson we’ll dive into further refining the speed at which After
Effects interpolates between values.
Layers can be smaller or larger than the composition and its “resolution”
(pixels per inch) is ignored by After Effects. In addition to fading a layer in and
out using its opacity, a footage item may also have an alpha channel that determines where the image is transparent and where it is opaque.
But before you start arranging and animating, you need to know how to make
a new project and comp, as well as how to import sources – so let’s get started!

After Effects compositions combine multiple
layers together. Movies courtesy Artbeats
Recreation & Leisure, Winter Lifestyles, and
Winter Scenes.

탋 factoid
File Format Support
For a full list of file formats that may be
imported in After Effects, open the program,
press ! to open the After Effects Help, and
search for “supported import formats.”
Individual layer properties may be keyframed
in the Timeline panel to create an animation.
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Starting a Project
In this first lesson, you’ll create a simple animation of a winter scene. To see
where you’ll end up, locate the movie First Animation_final.mov in this
lesson’s folder, and play it a few times in QuickTime Player. (To keep things
simple, we “pre-baked” the title and snowflake designs; the original sources are
included in our finished project. You’ll learn how to create text in Lesson 5, and
how to animate Shape Layers in Lesson 11.) Bring After Effects forward when
you’re done, and we’ll guide you through building this animation from scratch.

1
1

Set the Workspace to Standard and
then reset it to make sure you are starting
with the same arrangement of frames and
panels as we are. That way, our instructions
will make a lot more sense.

When After Effects is launched, it creates a new, blank project for you. In
the upper right corner of the application window, locate the Workspace popup,
and select Standard. To make sure you are using the original arrangement of
this workspace, from the same popup select Reset “Standard” (it’s at the bottom).
A Reset Workspace dialog will appear; click Discard Changes.

2

The Project panel can quickly become a confusing mess of sources and
comps. To avoid this, let’s create a couple of folders to help keep it organized.
Click on the New Folder icon along the bottom of the Project panel. A folder
called Untitled 1 will be created. It defaults to its name being highlighted; to
rename it, type “Sources” and press R (on a Windows keyboard, this is the
main E key – not the one on the extended keypad). You can rename it at
any time; just select the folder and press R to highlight the name.

3

Click in a blank area of the Project panel to deselect your Sources folder; the
shortcut to Deselect All is @. Now create a second folder. If you like, try using
the keyboard shortcut: COSn on Mac (LASn on Windows).
Rename it “Comps” and press R.
(If the Sources folder was selected when you created the Comps folder,
Comps will be nested inside Sources. Place it on the same level by dragging
the Comps folder outside of the Sources folder.)

Saving a Project

2

To create a new folder, click on the
folder icon along the bottom of the
Project panel. To rename it, type your
new name while “Untitled 1” is
highlighted, then press R.

4 Save your project by typing Cs (Ls). A file browser window will open;
save your project file in this lesson’s folder (Lesson 01-Basic Animation), and
give it a name that makes sense, such as “Basic Animation v1”.
It is a good idea to give projects version numbers so you can keep track of revisions; it also allows you to take advantage of the nifty File > Increment and Save
function. Instead of just saving your project, Increment and Save will save your
project under a new version number, leaving a trail of previous versions in case
you ever need to go back. The shortcut is COSs (LASs).
After Effects also has an Auto Save function; it’s under Preferences > Auto-Save.
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Creating a New Composition
5 Select the Comps folder you created in step 3. That way,
the new comp you are about to create will automatically be
sorted into it. Then either select the menu item Composition
> New Composition, or use the keyboard shortcut Cn
(Ln).
A Composition Settings dialog will open in which you
can determine the size, duration, and frame rate of your new
comp. At the top will be a popup menu for Preset, which
includes a number of common comp sizes and frame rates.
You can also enter your own settings. For this starting composition, uncheck the Lock Aspect Ratio box, then type in a
Width of 640 and Height of 480. Click on the popup menu
next to Pixel Aspect Ratio and select Square Pixels (we’ll
discuss pixels that are not square in the Tech Corner at the
end of Lesson 3).
The last parameter in this dialog is Duration. Highlight the
value currently there, and enter “4.00” for four seconds. Then make sure the
remaining settings are at their defaults: Frame Rate of 29.97, Resolution of Full,
and Start Timecode of 0;00;00;00. Don’t worry too much if you miss something;
you can always edit them later under Composition > Composition Settings.
A good habit to get into with After Effects is naming your compositions as
you create them. Enter “First Animation” in the Composition Name dialog,
then click OK. Your new comp will open into the Comp and Timeline panels.

5

These are the settings we will use for our
first composition. Remember to uncheck the
Lock Aspect Ratio box before typing in your
new dimensions. You can always change
these settings later by selecting Composition
Settings from the Composition menu.

6

Your comp will also appear in the Project panel, inside your Comps folder
(if it’s not in there, drag it in). If you cannot read the entire name in the Project
panel, just place your cursor along the right edge of the Name column and drag
it wider. Finally, save your project.

Importing Footage
There are two main ways to import footage into After Effects: using the normal
Import dialog, and using Adobe Bridge (covered in Pre-Roll). We’ll explore the
Import dialog here, but feel free to use Bridge if you prefer. (You can also drag
and drop from the Finder or Explorer, but that can be awkward as the After
Effects application window tends to take up the entire screen.)

7

It’s time to import some sources into your project. First, select the Sources
folder you created in step 2. Then use the menu item File > Import > File.
Navigate to the Lesson 01-Basic Animation folder you copied from this book’s
disc, and open the folder 01_Sources. Select Snowstorm Title.tif and click Open.

6 At this point, you should have a project
with two folders and one composition.
Notice the cursor to the right of the
Name column in the Project panel; we
just finished dragging this column wider
to view our comp’s entire name.
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쑽 Managing the Comp View
You learned in the Pre-Roll how to resize the user interface’s
frames. You can resize the frame that holds the Comp panel
to decide how much screen real estate you can devote to it.
There are several ways to control how this space is used to
display the comp’s image area:
• In the lower left corner of the Comp panel is a Magnification
popup. A popular setting for this is Fit up to 100%, which
uses as much of the Comp panel’s frame as it can up to full
size; that’s the setting we used when creating most of these
lessons and comps. A downside of the Fit option is that your
image can look a bit crunchy if the result is an odd size, such
as 78%. Therefore, some users prefer picking a set size such
as 100% or 50% that gets close to using the space available,
then resizing the frame again as needed.

The Import dialog will be replaced with an Interpret
Footage dialog. This file has an alpha channel: a grayscale
channel that sets the transparency of the RGB color channels. There are two main types of alpha channels: Straight,
which means the color has been “painted beyond” the
edges of the alpha channel, and Premultiplied, which
means the color is mixed (“matted”) with the background
color around the edges.
If you knew what type of alpha your file has, you could
select it here. Since you don’t, click Guess. In this file’s
case, After Effects will choose the Premultiplied – Matted
with Color White option, which is correct. Click OK, and
it will appear in your Sources folder.

8
• You can hold down C (L) and press the = key to
zoom in larger, or the - key to zoom out smaller.
• If you have a mouse with a scroll wheel, hover its cursor
over the Comp panel, and use the wheel to zoom in and out.
• For more targeted zooming, select the Zoom tool (shortcut = z), and click to zoom in and center around where you
click, or O+click (A+click) to zoom out. Don’t forget to
press v when done to return to the Selection tool!
• Even better, press and hold down the z key to temporarily
switch to the Zoom tool; add O (A) to Zoom out. When
you release the z key, the Selection tool will still be active.
• To pan around your composition, hold down the spacebar
to temporarily bring up the Hand tool, then click and drag
in the Comp panel to reposition it. (Tapping the spacebar
previews the timeline.)

To get the best results out of sources with alpha channels,
you want to select the correct alpha channel type. You can do
this while importing a file, or any time later using the Interpret
Footage dialog. After Effects has a Guess function to help.

9

Now it’s time to import some more sources. Make sure
the Sources folder (or a file inside it) is still selected, and
use the shortcut Ci (Li) to open the Import
dialog. Select Snowflake.mov, and click Open. This is
an animation created using Shape Layers in After Effects
(these are the subject of Lesson 11). We then rendered it
as a QuickTime movie with an alpha channel.

10

Finally, double-click on an empty area of the Project
panel – this will also open the Import dialog. Select the
folder named Movies, and click the Import Folder button.
This will import all the contents of the folder for you
with a single click; it will also create a folder with the
same name in the Project panel. Drag the Movies folder
inside your Sources folder, and save your project.
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Building a Comp
Now that you have your sources, you can add them to your comp, arrange
them, and have some fun animating them. First, make sure the Timeline and
Composition panels have the name of your comp (First Animation) in a tab
along their tops. If not, double-click this comp in the Project panel to open it.

Transform Fun
11 Select the footage item Snowstorm Title.tif in your Sources folder in the
Project panel, and drag it over to the image area of the Composition panel.
While keeping the mouse button down, drag it near the center of the comp:
You will notice After Effects tries to snap it into the center for you. With the
mouse button still down, drag near the four corners of the comp: After Effects
will try to snap the outline of the source against these corners.
Place it in the center, and release the mouse. It will be drawn in the comp’s
image area, and appear as a layer in the Timeline panel as well. (To get this
snapping behavior when you try to drag an already-added layer in the future,
press the CS (LS) keys after you start dragging a layer.)

After importing your sources, your Project
panel should look like this. Select a source
to see its thumbnail and details above.

11

When you first drag
a footage source into the
Comp panel, it will helpfully
try to snap to the center or
corner of the comp’s image
area. (From then on, the
layer will behave normally,
with no snapping behavior.)
The layer will appear in the
Comp and Timeline panels.
By the way, we have
dragged the Timeline’s A/V
Features column (circled in
red) from its default position
over to the right, to be near
the timeline. You can do
the same by dragging the
column header to the right
until it drops into place.
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The Comp’s background color defaults to black. Let’s change that so you
can see the drop shadow effect that is applied to the title:
Select the menu item Composition > Background Color. A color swatch and
eyedropper will appear. Click on the color swatch; the standard Adobe Color
Picker will appear. Drag inside the color field to select white. Click OK, and OK
again in the Background Color dialog to accept your changes. The text and its
shadow should now be easily readable against the white background color.

12

Pick white for this composition’s
background color.

13

In the Timeline panel, click on the arrow to the left of Snowstorm Title.tif:
This will reveal the word Transform. Click on the arrow to the left of Transform;
this will reveal all of the Transform properties for this layer. In the future, we will
refer to clicking these arrows as “twirl down” (and “twirl up” when closing a section).

Notice the numeric values next to each property: Place your cursor over one,
then click and drag while watching the Comp panel to see the effect of editing
these properties. This technique is referred to as scrubbing a value, and is a skill
you’ll use over and over in After Effects.
You can also type an exact value by clicking a value, which makes that field
active. Press T to advance to the next value, and press R when done.

13

To “scrub” a value in the Timeline, place
the cursor over the value until a two-headed
arrow appears, click, and drag. Scale has its
X and Y dimensions locked together, so
scrubbing one value also changes the other.

Some properties – such as Scale and Position – have separate X (horizontal,
or left-right) and Y (vertical, or up-down) dimensions to their values. By default,
Scale’s X and Y dimensions are locked together to prevent distorting the layer;
you can unlock them by clicking on the chain link icon next to their value.

14

After you’ve experimented with scrubbing, click on the word Reset to the
right of the Transform header to return these values to their defaults. Next
you’re going to play with directly manipulating the layer in the Comp panel to
edit its Transform properties. While doing so, keep an eye on the values in the
Timeline panel to get a better feel for what’s going on.
• To edit Position, directly click on and drag a layer in the Composition panel.
To constrain movement to one dimension, start to drag the layer, then hold
down the S key and drag some more.

14

Highlight a layer, then use the Selection
tool (shortcut v) to interactively scale a
layer by dragging its corners in the Comp
panel. The values in the Timeline will update
while you drag. It is easy to accidentally
distort the “aspect ratio” of a layer while
doing so (as we are here); add S while
dragging to constrain a layer’s proportions.

• To edit Scale, click and drag one of the eight square dots (“handles”) around
the outline of the layer in the Comp panel. To avoid distorting the layer and keep
its original aspect ratio, start to drag the layer, then hold down the S key and
drag some more.
• To edit Rotation, press w to select the Rotate tool (known affectionately to
some as “Wotate”), click on the layer, and drag around in circles. Add the S
key to constrain movement to 45° increments. When you’re done, press v to
return to the Selection tool ( V).
As before, click on the word Reset next to Transform to return these values
to their defaults.
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Animating Position
쑽 Transform Shortcuts

Now you know how to transform a layer manually; next comes making After
Effects transform a layer for you over time. This involves a process known as
keyframing.

The following shortcut keys reveal
specific Transform properties for the
selected layer(s):

15

There are keyboard shortcuts to reveal select Transform properties. With
Snowstorm Title.tif still selected, type p to reveal just its Position property.

You’re going to make this layer move onto the screen from below and settle
into place. Drag the title totally out of sight and onto the pasteboard just below
the Comp panel. Then make sure the current time indicator is at the start of
the timeline (the numeric time display in the Timeline panel should read
0;00;00;00). If it isn’t, grab the blue head of the current time indicator and
drag it there, or press H to quickly make it jump to the start.
To the left of the word
Position is a small stopwatch icon. Click on it,
and it will now be outlined and highlighted.
You have now enabled
Position for keyframing
and animation.
[The shortcut to toggle on and off the Position stopwatch for a selected layer(s)
is OSp (ASp).] Enabling keyframing also places a keyframe –
indicated by a yellow diamond to the right in the timeline portion of the
display – at the current time, using Position’s current value.

a

Anchor Point

p

Position

s

Scale

r

Rotation

t

OpaciTy

To add a property to those already
being displayed, hold down S
when you press these shortcuts.

15

In the Timeline panel, click on the
stopwatch icon next to the word Position
to enable keyframing for it; this also creates
the first keyframe (the yellow diamond).

16 Drag the current time indicator to 01:10 in the timeline. Pick up and drag
the Snowstorm Title.tif layer where you want it to end up. (We used a Position
value of X = 320, Y = 360.) A new keyframe will automatically be created for you
with this value, at the current time.
You may have noticed that a line appeared in the Comp panel, tracing the
path from where your layer started to where it is ending up. This is known as
the motion path. It is made up of a series of dots. Each dot indicates where that
layer will be at each frame in your timeline. The motion path is visible only
when the layer is selected.
Drag the current time indicator back and forth along the top of the timeline,
and notice how your layer moves along its motion path. To see what it would
look like playing back in real time, press 0 on the numeric keypad to initiate
a RAM Preview, or press the RAM Preview button at the right side of the Preview
panel. After Effects will work its way through the frames once as fast as it can,
then play back the animation in real time. Press any key to stop the preview.

16

Move to a different time, and drag the
layer to a new position; a motion path will
appear in the Comp panel illustrating its
travels (above). Click RAM Preview (below).
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It is easy to change the timing of keyframes: In the Timeline panel, drag
the diamond keyframes to the left or right to make them occur earlier or later
in time. RAM Preview to see the new timing, then return it to 01:10.

18

18

탋 tip

If you don’t jump to the exact time of a previously existing keyframe, you will
instead create a new keyframe. If you create one by accident, you can delete it by
selecting it in the timeline and pressing D. Or, use the keyframe navigation
arrows to jump to it, then click on the yellow diamond between the arrows to
remove it.

Under the A/V Features column are
a pair of keyframe navigation arrows,
which make it easy to jump to the
previous or next keyframe for a given
property. If the diamond between them
is yellow, the current time indicator is
parked on top of a keyframe.

Multiple Undos
By default, you have 32 levels of Undo in
After Effects. If that’s not enough, you can
set it as high as 99 in Preferences > General.

You can also easily edit the value of a keyframe after you’ve created it. In the
A/V Features column of the Timeline panel are a pair of gray arrows surrounding
a small diamond. These are known as the keyframe navigation arrows. Clicking on
them will jump to the next keyframe in line for that property, confirmed by the
diamond changing from hollow to yellow. Once you’re “parked” on a keyframe,
to edit that keyframe either scrub the layer’s Position values, or drag the layer
around in the Comp panel.

Save your project. Indeed, now would be a good time to use the File >
Increment and Save option, so your work to date will be saved under a new
version number.

Adding a Background Layer
19 To add interest, let’s bring in our background layer. In the Project panel,
open the Sources > Movies folder, select Landscape.mov, and drag it to the left
side of the Timeline panel so it sits below the title layer. It should fill the Comp
panel. RAM Preview to see how it looks.

20

19–20

Add Landscape.mov as a
background and reduce its Opacity (right)
so that it appears “ghosted” (above).

Note that because the background
color is white, if you make the background movie semitransparent, it will
appear more pale and “ghosted.” With
Landscape.mov selected, press t to
twirl down Opacity property, and scrub
its value to taste.
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Adding a Middle Layer
The Snowstorm title has a missing “o” that will be filled in by adding an animated snowflake icon (yes, we desperately needed something for you to animate
along a curve…). First, let’s learn a few more tricks for adding footage to a comp:

21

In your Sources folder in the Project panel, select the footage item
Snowflake.mov:
• Drag Snowflake.mov down to the left side of the Timeline panel, near the
names of your other layers. Hover your cursor above your existing layers, and
you will see a thick black horizontal line, which indicates you’re about to place
it above these layers. Drag it downward until this line appears between both
layers and release the mouse. The new layer will appear as Layer 2, behind the
title and in front of the background movie. Note that no matter where the
current time indicator was parked, the new layer starts at the beginning of the
comp (00:00).
• Press Cz (Lz) to Undo
this addition, and try another
method. This time, drag
Snowflake.mov to the right side
of the Timeline panel until your
cursor is hovering over the timeline
area. You should see a second blue
time indicator head appear. This
indicates where it would start in
time if you were to release your
mouse now, and provides an interactive way to decide your initial
starting time. You can also move it up and down in the layer stack with this
method. Pick some location in the middle of the timeline, and in the middle of
the two layers, and release the mouse. The new layer will be added at the time
you’ve picked. (If the snowflake is not visible, check if it ended up below the
background movie; if so, drag it up one layer so it is Layer 2.)

22

Drag the current time indicator back and forth, and notice how the
snowflake symbol does not appear in the Comp viewer until after the current
time indicator crosses the start of the layer in the timeline. You can click and
drag the center of the layer bar for Snowflake.mov to make it start sooner or
later in time; for now, avoid dragging the ends of the layer bar, which trims the
layer. (Moving and trimming layers is covered in more detail in Lesson 3.)
Finally, with Snowflake.mov still selected, press OH (AH) to
make it start at the beginning of the comp and let’s animate it into position.

탋 factoid
Comp versus Timeline
When you add a layer to a comp by dragging
it to the Timeline panel, the layer will be
automatically centered in the Comp panel.
When you add a layer to the Comp panel, the
default is to start the layer at 00:00 (set by
Preferences > General > Create Layers at
Composition Start Time). Toggle this off to
add layers starting at the current time.

21

When you drag a new source from the
Project panel to the Timeline panel, you can
decide when and where to drop it in the layer
stack. Notice the ghosted outline and second
current time indicator before we let go of
the mouse (top), and how it corresponds to
the layer’s placement after we let go (above).

탋 tip
Quick Location
To make a layer start where the current
time indicator is, select it and press [
(left square bracket).

Excerpt from After Effects Apprentice, 2nd Edition. Copyright © 2009 Trish and Chris Meyer.

Lesson 1

No part of this publication may be reproduced or distributed in any form or by any means.
Focal Press, ISBN 978-0-240-81136-9

24

Crafting a Motion Path

탋 future vision
Drawing a Path
In the next lesson, we will demonstrate
the Motion Sketch Keyframe Assistant,
which gives you a fun, interactive way
to create a motion path.

Right now, the snowflake movie is dominating the center of your composition.
The plan is to have it fly across across the screen and land in place of the
missing “O” in the Snowstorm title.

23

Let’s allow the title to settle into place at 01:10 and then have the snowflake
drop into position 10 frames later at 1:20. To move to an exact point in time,
you can click the timecode readout in the Comp or Timeline panels to open the
Go To Time dialog, enter “1.20” and press OK.
Next, click on the snowflake in the Composition panel,
and drag it into place where the missing “O” should be.
You can use the cursor keys to nudge it into place.

23

Place Snowflake.mov where the
missing “O” should be in Snowstorm
Title.tif.

Then drag on one of the layer handles (the eight boxes
around its edges) for Snowflake.mov to scale it down to
a good size that will fit in with the rest of the title. Hold
down the S key after you start dragging one of these
handles to force the layer to keep its original aspect ratio;
otherwise, the snowflake will be distorted. We used a Scale value of 23% but
feel free to size to taste.

24 With Snowflake.mov still selected, press p to reveal its Position, then
click on its animation stopwatch to enable keyframing (just as you did for the
Snowstorm Title.tif layer back in step 15). This will create a Position keyframe
at 01:20 with the current value (you will animate Scale a little later).
Move the current time indicator to the start of the
composition (00:00 in time); the shortcut is to press H.
Drag the snowflake to the upper right corner of the comp.
A new Position keyframe will be created at this time, and
you will see a motion path line join the two keyframes in
the Comp panel. The dots along this line indicate the
layer’s position at each frame in time; the spacing between
these dots indicates how fast it is moving.

24

After creating two
Position keyframes, tug
on the Auto Bezier
handles (right) to create
a motion path that arcs
across the comp (left).
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If you look closely, you will see two slightly larger dots
along the motion path line, close to each keyframe icon.
Motion path keyframes default to an interpolation type
known as Auto Bezier, which automatically tries to smooth
the path. These dots are the interpolation handles for those
keyframes. Pull them toward the upper left corner of the
comp to cause the snowflake’s path to arc across the screen.
If you cannot see these handles, hold down CO (LA)
and drag in the Comp panel from the keyframe icon outward
to create visible handles. If you accidentally drag the background layer instead, Edit > Undo, reselect Snowflake.mov,
and try again.
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To make the flight path even more interesting, move
the current time indicator to 00:25 (between both keyframes),
and drag the snowflake to a new position. A new Position
keyframe will be created automatically, and the motion path
will bend to connect your three spatial keyframes. Tug on the
Bezier handles protruding from the keyframes to create a more
interesting motion path. RAM Preview, and save your project.

쑽 Spatial Keyframe Types
The position keyframes in the Comp viewer are referred
to as spatial keyframes, as they define where the layer is
supposed to be in space at a given time. How the motion
path flows into and out of a spatial keyframe is also important, and can be deciphered both by looking at the path
itself, and by looking at a selected spatial keyframe:
• The default spatial keyframe type is Auto Bezier. It is
indicated by two dots in a straight line on either side of
the keyframe (A). This means After Effects will automatically create a smooth bend through this keyframe.
• Dragging one of these dots results in the keyframe
being converted into a Continuous Bezier type, indicated
by the straight line (“handle”) that connects the dots (B).
You can drag this handle to explicitly control how the
motion path flows through the keyframe.
• If you want to create a sudden change in direction at
the keyframe, hold down g and drag one of the handle’s
dots to “break” their continuous nature. You can then drag
the handles of this Bezier keyframe independently (C).
• To create a hard corner without a curve or handles,
hold down g and click the keyframe’s vertex itself to
convert it to a Linear keyframe (D).

25

Add a
third keyframe
and play with
the motion
path’s Bezier
handles to
create a more
involved flight
path.

If you noticed a speed shift in the snowflake’s flight, this is
because it is traveling farther between one pair of keyframes
than between the other pair. You can confirm this by looking at
the spacing of the dots along its motion path: Different spacing
means different speeds. Slide the middle Position keyframe in
the timeline until the dot spacing is more balanced. (In the
next lesson you’ll learn how to precisely edit a layer’s speed.)

• To return a Linear keyframe to an Auto Bezier keyframe, hold down g and click on the keyframe again.
Press v to return to the Selection tool when done.

A

Auto Bezier

B

Continuous Bezier

C

Bezier

D

Linear
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Animating Opacity, Scale, and Rotation

탋 key concept
Anchor Point
Notice how the snowflake scaled and
rotated around its center? That’s because
we centered it when we made it. You
won’t be so lucky with other sources; they
may appear to wobble when they rotate.
The cure for this is setting the Anchor
Point, which you’ll learn in Lesson 2.

Having a layer “fly into position” rarely involves just Position keyframes; you
can also animate its Scale parameter to make it appear to fly toward or away
from you, and its Opacity parameter to have it fade up or down.
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You have already created a good ending pose for the snowflake that works
nicely in relation to the rest of the Snowstorm title. Therefore, first you will
want to create keyframes to remember this pose:
• Move the current time indicator to 01:20 to align with the final Position
keyframe for Snowflake.mov. Remember that you can press the S key as
you drag to “snap” to existing keyframes, or use the keyframe navigator arrows
to jump to the next or previous keyframes.
• Select Snowflake.mov.
Its Position parameter should
already be revealed. To
reveal additional properties,
hold down the S key,
then press s for Scale and
t for Opacity.

26

To remember your ending pose, create
keyframes for Scale and Opacity aligned in
time with your final Position keyframe.

• Click on the animation
stopwatch for Scale and
Opacity to enable keyframing for these parameters. This creates keyframes with
their current values at the current time (01:20).

27 Move the current time indicator to 00:00 (shortcut = H), when the
snowflake’s flight begins. Scrub Snowflake.mov’s Scale parameter in the
Timeline panel while watching the result in the Comp panel and pick a nice
starting size. It can be larger or smaller than its final Scale value, depending on
the visual effect you want. One thing to keep in mind is that with most layers,

탋 tip
Slow Scrubbing
To scrub a value by smaller increments
for precise control, hold down the
C (L) key while scrubbing.
To jump by larger increments,
hold down S while scrubbing.

쑽 Nudging Position, Rotation, and Scale
Sometimes it’s easier to use the keyboard to nudge the transform values for a layer.
Here are the magic keys:
Position:

cursor keys ˆ Δ ˚ μ

Rotation:

numeric keypad’s + and -

Scale:

O (L) plus numeric keypad’s + and -

If you hold down the S key while doing any of these, the transform values will jump
in increments of 10 rather than 1.

Excerpt from After Effects Apprentice, 2nd Edition. Copyright © 2009 Trish and Chris Meyer.

Lesson 1

No part of this publication may be reproduced or distributed in any form or by any means.
Focal Press, ISBN 978-0-240-81136-9

27

it is a bad idea to increase Scale past 100%, as this may result in softening of the
image plus other visual artifacts.
You may also enter keyframe values numerically. Click on the Scale value in
the timeline, which will highlight it. Type in your new value and press E or
R. You can also double-click a keyframe, which will open a dialog where
you can enter your desired value. The advantage of double-clicking a keyframe
is that you can edit it without having to first align the current time indicator
with the desired keyframe.
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To have the snowflake fade on, you need to reduce its initial Opacity value.
With the time indicator still at 00:00, scrub Snowflake.mov’s Opacity value to
the left to reduce its opacity. A value of 0% means fully transparent. You can
also directly enter a number such as 0. RAM Preview to test your animation.
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If you want to add more complexity to your animation, you can animate
its Rotation property as well:
• Place the time indicator at 01:20.

• To work faster, hold OS (AS) and press r: This will reveal the
Rotation parameter, plus enable keyframing for Rotation.
• Move the time indicator to 00:00.
• Enter a new initial Rotation value, such as –90°.
RAM Preview to test your new animation, and tweak the parameters to taste.
When satisfied, File > Increment and Save to save a new project file.

27–28

Animate the snowflake’s Scale
and Opacity values to cause it to fade up
and fly down as it moves into position.
Note that you can edit values numerically
in the Timeline panel (top).

탋 try it
Smooth Moves
By default, After Effects creates linear
keyframes in the timeline. These result
in sudden starts and stops. Keyframe
interpolation and velocity are covered in
the next lesson. But until then, to add a
more elegant touch, you can select a
starting or ending keyframe and press (
to apply the Easy Ease keyframe assistant,
which will create smooth starts and stops.
(Mac users will have to change Exposé in
System Preferences to free up the shortcuts
( – ™.)

